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Analyzing Data with Excel 2002
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In many learning situations, students are presented with data in the form of published studies, textbook examples, and media presentations. Although students may absorb some information from reading someone’s analysis of data, they are likely to become even more engaged in the process of collecting and analyzing data on their own. Microsoft( Excel 2002, along with the other programs in Microsoft Office XP, facilitates active, collaborative learning and critical thinking by providing tools that empower students to collect information, look at it in different ways, and share it with others. 

Everyone knows that Excel is a “spreadsheet” software program that is used to record data; however, Excel is also a tool for analyzing that data. Perhaps you are already using a spreadsheet to keep track of your students’ grades. You might even be analyzing patterns in those grades. Excel 2002 makes it possible to perform the same kinds of analyses on data from all kinds of sources, including text files, databases, and the Web. Excel’s PivotTable features enable you to analyze large amounts of complex data in a flexible manner and summarize your findings in a graphical format. 

You will follow along with a group of social-science students and their instructor as they collect and analyze data about students planning to major in math and science. They will import data from a text file, query a Microsoft Access 2002 database, and gather data from the Web. Next, they will analyze the data by using PivotTables( and looking at it in PivotCharts(. Finally, they will share their analysis and continue their research by using interactive Web pages. Sample data files are provided for you to use.

Before You Begin

[image: image14.png]" tter



If you are new to Excel 2002, you may want to read the documentation that came with your Office XP software. Additionally, all copies of Office XP purchased through a retail store or volume licensing includes the Microsoft Press Step by Step Interactive CD. Step by Step Interactive provides an excellent introduction to the basic functions of Excel 2002. If Excel was provided to you through a volume purchase, discuss with your administrator how to access the Step by Step Interactive program.

To install Excel 2002, you will need:

· Personal or multimedia computer with a Pentium or higher processor (Pentium II recommended)

· 32-megabytes (MB) of RAM (minimum)

· 295-MB hard disk

· CD-ROM or DVD-ROM drive

· VGA or higher-resolution video adapter (Super VGA, 256-color recommended)

· Microsoft mouse, Microsoft IntelliMouse®, or compatible pointing device

Some activities also require: 

· Network connection and modem

· Access to the Internet through a service provider

If you have not already done so, make sure that you download the following sample data files that accompany this tutorial:

· analyzing_data.xls

· major_database.mdb

· text_file.txt

These sample files can be found on the Microsoft in Education Web site at the following URL (type analyzing data in the Search field):

http://www.microsoft.com/education/ 

Conventions

The directions given in this tutorial use the following conventions:

· To “click,” use the mouse to point to an area on the screen and press the left (primary) mouse button. To “double-click,” press the left mouse button twice, quickly. To “right-click,” press the right (secondary) mouse button. (You can also customize the mouse so that the right button is primary and the left button is secondary.)
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Items such as menus or buttons that you click or select to carry out a command are bold. For example, "click Print" means you should click the Print command on the File menu.

· Information that you are to type exactly is shown in bold. 

Getting Help

For assistance with Excel 2002, you can use the Office Assistant. To open the Office Assistant, on the Help menu, click Show the Office Assistant. You can then type your question in the text box provided, and then click Search.
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Using Excel

[image: image17.png]" tter



[image: image18.png]" tter



Before using Excel 2002, you will want to be familiar with its features. The following illustration shows a workbook that contains data.
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Worksheets

The basic Excel document is a worksheet. Several worksheets can be saved together as a workbook. When you start Excel, a blank worksheet opens. You can then complete the following tasks:

· Add data manually. Type text and numbers in cells.

· Create formulas. Calculate results from the data by applying formulas to cells. Formulas can be up to 1,024 characters and can contain operators, cell references, values, text, and functions.

· Navigate. To change the active cell, use the arrow and PAGE UP and PAGE DOWN keys, click a new cell, or drag the scroll bars.  

· Select cells. Click a cell and drag the mouse pointer to select a range of cells. To select nonadjacent cells, hold down the CTRL key and then click on the cells you want.

· Add a new worksheet to form a workbook. Click Insert and then click Worksheet, or right-click the tab of the active worksheet to open the context menu, click Insert, and then click Worksheet.

· Rename the worksheet and color the name tabs. Double-click the Sheet1 tab to select it, and then type the new name, or right click Sheet 1 and select tab color to color code the tabs for easier navigation between worksheets.

· Format the worksheet. Change or apply font styles, colors, patterns, borders, and cell alignment to make your worksheets more attractive and easier to read. Select the cells that you want to format, and on the Format menu, click Cells.

· Embed charts and pictures. To create a new chart within Excel, on the Insert menu, click Chart. To insert another file, such as clip art or a scanned image, on the Insert menu, point to Picture, and then click a command. 

Before getting started with this tutorial, it would be helpful for you to spend some time exploring Excel. One of the easiest ways to become familiar with a new program is to view the menus, see what some of the buttons do, and explore Help. 

To view Help

1. On the Start menu, point to Programs, and then click Microsoft Excel.

2. On the Help menu, click Microsoft Excel Help.

3. Type the question How do I save a workbook? in the text box provided, and then click Search. 

4. You can view the topic that is displayed in the right pane, or select one of the additional topics for more information.

Now that you are familiar with some of the basic features of Excel 2002, you are ready to find out how you can use Excel to facilitate engaging, collaborative learning activities with students.  

In a social science class, students were asked to pick a current issue of interest and then compare the attitudes of their peers with those reported in a national poll. The students were then required to share their research with others. One group chose to look at students planning to major in math or science. With Excel 2002, the students are able to gather data from several locations, analyze it to answer questions of interest to them, and then share what they discover.

Importing Data

The social science students have found several data pools in their research that they want to bring together and analyze. Before they can analyze data, they have to get it into a format Excel can use. This usually means typing or importing data into a worksheet. There are several ways to do this, including:

· Type data manually

· Generate data by using forms or macros

· Import data from another file, such as a text file

· Import data from a database 

· Import data from the Web

Importing data from text files

The social science students found some statistics about student ethnicity and the selection of science majors that they thought would be important for their study. However, the information wasn’t in an Excel file. Excel can’t read every type of file that exists, but most programs will allow you to save data as a delimited text file that can then be imported into Excel. Delimited means that each section of data is separated by a special character, typically a tab, comma, quote, or space. The students saved the file as a text file (text_file.txt) and are now ready to import it into Excel.

To import a delimited text file

5. On the File menu, click Open. 

6. Select the folder where you downloaded the sample data files, and double-click analyzing_data.xls.

7. Click the Sheet1 tab to select it.

8. Click Data, point to Import External Data, and then click Import Data.

9. Switch to the folder from which you opened the workbook, and change the Files of type to Text Files. Select the text_file.txt file(located in the sample_data folder that you downloaded with this tutorial), and then click Open. The Text Import Wizard opens.

10. Verify that Delimited is selected, and then click Next.

11. Verify that Tab is selected, and then click Next.

12. Verify that General is selected, and then click Finish.

13. Verify that Existing worksheet is selected, and then click OK.

14. On the File menu, click Save.

Later, if the data in the text file changes, you can update your Excel worksheet without importing the text file again. To do so, on the Data menu, click Refresh Data. Select the text file, and then click Import. Excel automatically updates the worksheet with any new data that is in the text file.

Importing data from a database

The social science students also conducted their own survey of college freshman at their school. They used a Web-based form created in Microsoft FrontPage® 2002 and arranged for students from several English 102 classes to fill out the form online. They collected the results of their survey in an Access 2002 database.

In order to analyze and compare their survey with the national statistics, the group needs to import some of the survey data into Excel. They can query the database to isolate a subset of the data collected in the survey. Excel has a Query Wizard that makes it easy to retrieve data stored in an external database.

To query a database

15. In the analyzing_data.xls spreadsheet click the Sheet2 tab to select it.

16. On the standard toolbar, click Data, point to Import External Data, and then click New Database Query.

17. On the Databases tab, click MS Access Database, click Use the Query Wizard to create/edit queries, and then click OK.

18. Locate the major_database.mdb database file (located in the sample_data folder that you downloaded with this tutorial) in the Select Database dialog box, and then click OK. The Query Wizard opens.

The Choose Columns Query Wizard prompts you to select the columns that you want to include in your query. The list on the left shows the tables and columns available from the database that you queried. The list on the right contains the columns that you want to include in your Excel worksheet.

19. From the list on the left, click Declared major by gender and ethnicity, and then click the right arrow. The columns from the database table are now listed on the right.

If you want to remove any columns from the list, select the heading and click the left arrow. For this query, you probably don’t have any use for the arbitrary ID number that was assigned to each record. Click Student ID #, and then click the left arrow. 

You can also preview the data in a column. Select age from the list on the right, and then click Preview Now. You will see the numbers 17 through 21 listed in the Preview Data list. These are the possible ages of the students who were surveyed. Click Next to continue. 
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20. The Filter Data Query Wizard allows you to filter the data that you are querying directly from the database. For example, if you wanted to include the records only of minority students, you could do so here. The social science students want to see all the data in Excel, so they chose not to filter data at this point. Click Next.

21. The Sort Order Query Wizard allows you to sort the data that you are querying from the database by ascending or descending order. The students might want to sort their data later in Excel, but choose not to do so here. Click Next to continue.

22. Click Return Data to Microsoft Excel, and then click Finish.

23. Verify that Existing worksheet is selected, and then click OK. Notice that you can also create a PivotTable Report directly from a database query. PivotTables are discussed later in this tutorial. The data from the database opens in Sheet2. The External Data toolbar also appears.

Importing data from the Web

With Excel 2002, you can use data that you find on the Web. Conducting a Web query is very similar to conducting a database query. Excel 2002 remembers where the data came from, so that you can refresh your query if the data changes. The social science students want to compare their data with historical statistics on college graduates from the US Census Bureau. Census Bureau reports are located on the Web at http://www.census.gov/population/.

To create a Web query

24. In the analyzing_data.xls spreadsheet, click the Sheet3 tab to select it.

25. Click Data, point to Import External Data, and then click New Web Query.

26. In the Address box, type the address of the Web page. In this case, type http://www.census.gov/population/socdemo/school/tabA-6.txt
27. Select the yellow boxes next to the portion of the page you want to reference in your query, and then click Import.

28. Verify that Existing worksheet is selected, and then click OK. The census data is imported into the Excel worksheet. 

Analyzing Data

After you have gathered your data into Excel, you can perform many kinds of analyses, from simple filtering to advanced “what-if” analysis. By using the powerful PivotTable feature of Excel 2002, you can accomplish this without creating a single formula.

The social science group has brought data together from several sources into the Excel workbook analyzing_data.xls. They are now ready to find out what their data means. They will first perform a simple analysis by filtering a list. Next they will do a more complex analysis of the data by using PivotTables and looking at the results of the analysis in PivotCharts.

Filtering a list

Filtering a list is a method of analysis in which you hide rows in the list that do not meet some specified criteria. For example, you could filter a grade-book list to show only those students who did not declare a major. You could then perform a mail merge with the results and mail notices only to those students. 

The social science students hypothesize that participation rates of females in science and engineering in 1998 is greater than participation rates of minorities. To explore this hypothesis, students used the following procedure and the filter_list worksheet in the analyzing_data.xls sample file. This worksheet contains national data about the numbers of minority students intending to major in science and engineering. It is similar to the Excel worksheet created from importing the text file earlier in this tutorial.

To filter a list by using AutoFilter

29. In the analyzing_data.xls spreadsheet, click the filter_list tab to select it.

30. Click cell A3 in the worksheet to activate the cell.

31. Click Data, point to Filter, and then select AutoFilter. Drop-down arrows appear next to the field names in the header row.

32. You can filter the list by values in a single column or in multiple columns. For example, click the drop-down arrow on the 1998 field and then click (Top 10). The Top 10 AutoFilter dialog box opens.

33. You can change the parameters to return any number of the top or bottom items or percentages. For this exercise, leave the filter parameters at Top 10 items.

34. Click OK. All rows are hidden except the ten with the highest number of freshmen intending to major in science and engineering in 1998. To filter the list further, you can select an additional year, or you can click the drop-down arrow for the 1998 field and click (All) to remove filtering of the column.

35. To turn off AutoFiltering and return to the complete list, click Data, point to Filter, and then click AutoFilter to clear the check box.

36. You can start filtering the list from any row. If you want to see results only for minorities intending to major in science and engineering, click row 21, click Data, point to Filter, and then click AutoFilter. The drop-down arrows appear at line 21 instead of at the top of the list.

37. To display your filtered list as a chart, on the Insert menu, click Chart. The Chart Wizard opens to help you format your chart. As you change the AutoFilter criteria, the chart automatically updates to reflect the changes. For more information about charts, refer to the Office Assistant.

You can also filter a list with the Advanced Filtering feature. Advanced Filtering allows you to specify more complex filtering criteria and extract the rows that meet the criteria to another location. Advanced filter criteria can include multiple conditions applied in a single column, multiple criteria applied to multiple columns, and conditions created as the result of a formula. For example, social science students may use Advanced Filtering to compare participation rates of women in specific majors from 1990 to 1998. For more information about Advanced Filtering, refer to the Excel 2002 Help.

Creating PivotTables

Like the AutoFilter feature of Excel, a PivotTable enables you to highlight data that meets specific criteria while hiding the remainder. PivotTables make this especially easy when analyzing large quantities of data that contain both numerical data and non-numerical data, such as a college name, ethnicity, gender, or major.

A PivotTable enables you to summarize data by comparing, or organizing, the data in various formats by using the row and column headings. For example, you might want to find out how many Asian students major in History at a specific college, then compare that number with the number of Asian students that major in mathematics. PivotTables enable you to organize these multiple sets of data at the same time.

One reason PivotTables are so useful is that they are flexible. After you have completed the collection of your data in a spreadsheet, you can manipulate the organization of the data by rearranging or pivoting the layout based on the row and column headings you choose. In the example, you might want to further explore your data to see if more Asian men than Asian women major in history, or if the same trend is present at a different college. You can change the layout at any time by adding or removing headings to find these trends or exceptions while your original data set remains intact. Your data analysis can then be graphically expressed by using the PivotChart feature. 

To create a PivotTable

38. In the analyzing_data.xls spreadsheet, click the Database tab to select it.

39. In the upper-left corner of the worksheet, click the Select All button to select the data on the worksheet.

40. Click Data, and then click PivotTable and PivotChart Report. The PivotTable and PivotChart Wizard open.

41. Click Microsoft Excel List or database as the location of the data to analyze, click PivotTable, and then click Next.

Note:
If you want to create a PivotTable from external data, select External Data Source. Click Next, and then click Get Data. If Excel prompts you to install Microsoft Query, click Yes. Excel displays the Choose Data Source dialog box, which you can use to specify a data source such as a database or online analytical processing (OLAP) cube.

42. Because you have already selected the worksheet (step 2), the correct data range should be typed in the Range field. (The range is surrounded by a pulsing dashed line.) Click Next. If the data is not selected, click Cancel and return to step 2.

43. Select Existing Worksheet as the location for the data, and then click the PivotTable tab and then click the Select All button to activate the PivotTable worksheet.

44. Click Layout to open the Layout dialog box.

45. You can ask different questions of the data and look at it in different ways depending on which fields you decide to use for rows, columns, and data. For example, if you want to see which majors are the most popular with men and women of different ethnic groups, drag the gender and ethnicity fields to the Row box on the PivotTable diagram. Drag the planned major field to the Column box. Drag the planned major field to the Data box. (Notice that you can use the same field in more than one place.) 
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46. When you are finished, click OK, and then click Finish. The PivotTable opens and the PivotTable toolbar appears. 

To explore another question with the same data, you can drag the fields on and off the PivotTable. For example, if you want to see whether men or women are more interested in science and engineering and if this changes based on age, you would drag the ethnicity field off the PivotTable, and the planned major field off the Row box. Then you would drag the age field to the Row box and the category field to the Column box. You can drop down the Category list to select only science and engineering categories.

Working with PivotTables

PivotTables are dynamic worksheets—you can change and rearrange them to ask different questions and to look at your data in different ways. The first thing you want to do is work with the PivotTable buttons to change the field parameters. For example, when analyzing participation rates, you can change the page field data to display information about any of the participating ethnic groups. You can change the page field altogether to categorize the data differently, by gender or by college, for example.

The following illustration shows a PivotTable report of the sample data. The shaded cells are PivotTable buttons. You can drag buttons between rows and columns to change the way data is summarized. Click the arrow on a button to select which data to display for the field. In this example, only engineering majors are displayed, but it is easy to change this by selecting a new item from the planned major drop-down list. To customize the way data is summarized, double-click a button.
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The following vocabulary will help you change the layout of your PivotTable report:

· Row fields. Fields from the underlying source data that are assigned a row orientation in a PivotTable report. In the above example, gender is the row field. A PivotTable report that has more than one row field has one inner row field, the one closest to the data area. Any other row fields are referred to as outer row fields. Inner and outer row fields have different attributes. Items in the outermost field are displayed only once, but items in the rest of the fields are repeated as needed.

· Column field. A field that is assigned a column orientation in a PivotTable report. In the above example, planned major is the column field. A PivotTable report can have multiple column fields just as it can have multiple row fields. 

· Item. A subcategory, or member, of a PivotTable field. Items represent unique entries in the same field, or column, in the source data. Items appear as row or column labels or in the drop-down lists for page fields.

· Page field. A field that is assigned to a page, or filter, orientation. In the above example, ethnicity is the page field. When you click a different item in a page field, the entire PivotTable report changes to display only the summarized data associated with that item.

· Page field item. Each unique entry or value from the field, or column, in the source list or table becomes an item in the page field list. 

· Data field. A field from a source list or database that contains data to be summarized. A data field usually summarizes numeric data, such as statistics or sales figures, but the underlying data can also be text. By default, Excel summarizes text data in PivotTable reports by using the Count summary function and summarizes numeric data by using Sum. 

· Data area. The part of a PivotTable report that contains summary data. The cells of the data area show summarized data for the items in the row and column fields. Each value in the data area represents a summary of data from the source records, or rows.

Using the PivotTable toolbar

The PivotTable toolbar allows you to work with your PivotTable easily without needing to access the PivotTable and PivotChart Wizard. The following illustration shows the toolbar created with the PivotTable in the previous procedure and its features. When you create the PivotTable, numerical data is summed by default and non-numerical data is counted. You can change the operation performed on data in a field of the PivotTable by clicking a cell in that field and then clicking the (Field Settings) button. Use the PivotTable Field dialog box that appears to specify the operation you want Excel to perform in that field. For example, you can use this button to sum up the total number of students per major in your PivotTable.
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Formatting your PivotTable Report

You can also format and customize the look of your PivotTable report. Try the following tasks:

· Add a field. Select any field in the PivotTable and then drag the field that you want to add from the PivotTable Field List onto the PivotTable.

· Customize a field. Double-click a field button to change the field button name, the orientation of field items, and the type of subtotaling displayed. You can also hide items.

· Remove a field. Click the field button and drag it away from the PivotTable. When the pointer changes to a button with an X across it, release the mouse button. 

· Reformat the PivotTable. On the PivotTable toolbar, click Format Report to open the AutoFormat dialog box.

· Group similar items to hide details. Select the cells that you want to group together. Click Data, point to Group and Outline, and then click Group. For example, you could group the 17, 18, and 19 year-olds together and then group the 20 and 21 year-olds together. Excel names the groups Group1, Group2, and so on. You can rename the groups by selecting the name and typing a new one.

· View details. To see the records used to generate a summary value, double-click the appropriate summary cell. Excel opens a new worksheet containing the records used to create the summary.

Viewing your analysis with PivotCharts

A PivotChart is a chart linked to a PivotTable. You can create a PivotChart by using the PivotTable and PivotChart Wizard. You can drag and drop fields onto a PivotChart just as you can onto a PivotTable. To create a PivotChart, click the Chart Wizard button on the PivotTable toolbar. The PivotChart is created on a separate Chart worksheet. To embed the PivotChart within the PivotTable, activate the Chart worksheet, click Chart, and then click Location. Select As object in and specify the PivotTable worksheet for the PivotChart.

Visual representation of data is a powerful analysis tool used by researchers and scientists. The social science students are developing a report of their analysis and would like to include a chart for maximum impact. The following illustration shows a PivotChart based on the previous PivotTable report that was created by the students.
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To create and customize a PivotChart

With the PivotTable still open, you can create a PivotChart from your existing PivotTable report.

47. Click the Chart Wizard button on the PivotTable toolbar. The default chart type will open on a separate Chart worksheet. (Notice that the shortcut menu on the toolbar is now labeled PivotChart instead of PivotTable.)

48. To change the chart type, click the Chart Wizard button on the PivotTable toolbar again. The Chart Wizard opens.

49. Select from one of the standard or custom chart types and then click Next.

50. In the Chart Options Chart Wizard, you can give the chart a title, show or hide gridlines, change the placement of the chart legend, change data labels, and show a data table with your chart. 
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51. The Chart Location Chart Wizard allows you to select a location for your PivotChart, as a separate worksheet or embedded in your PivotTable report.

52. Click Finish to display your PivotChart. Remember that, as you drag and drop field buttons, your PivotChart automatically updates.

Using Excel 2002 on the Web

Excel 2002 recognizes HTML as a native file format, allowing you to put your Excel files on the Web and then “round-trip” them back to Excel without losing any of your Excel formatting. This allows you to share your data analysis on the Web and even continue your data research through interactive worksheets, PivotTables, and PivotCharts.

Creating interactive Web pages

After the social science students have analyzed the data in Excel, they may want to publish their findings on the Web for others to see. This is especially helpful when students are collaborating with groups outside their own school to develop large-scale projects. For example, the social science students are collaborating with other departments and universities to develop programs for high school students to encourage participation in engineering programs. The analysis of participation rates will help identify the target populations for such programs.

Students have two basic options for publishing their findings to the Web—they can publish a snapshot of the data, as a graphic in a larger report, or they can publish the data and include interactivity, so that other students can manipulate and analyze the data in different ways.

To save an Excel worksheet in HTML format

53. On the File menu, click Save As. 

54. In the Save as type list, select Web Page. 
The Save As dialog box allows you to specify whether you want to save the entire workbook or only the active worksheet as a Web page. 

55. If you select the active worksheet and you want others to be able to manipulate your data, click Add Interactivity. 

56. Click Publish if you want to specify which items in the workbook you want to publish and which type of interactivity you want to add.
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The advantage of putting your data on the Web is that users can access and interact with your data without having Excel installed on their computers. All that users need is a Web browser and access to the Internet or an intranet. For example, with PivotTable interactivity added to a PivotTable worksheet, viewers can pivot and filter the data in a Web browser in the same way that they can in Excel. 
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If you save your data with interactive functionality, Office XP users can work with the data and make changes to it by using Microsoft Internet Explorer version 4.01 or later, much as they would use Excel to work with the data. For example, they can rearrange cells and update cell values in a spreadsheet, and filter or change the layout of a PivotTable list. Spreadsheets, PivotTable lists, and charts can all be interactive. If you save your data in a non-interactive format, users can only view the data. 

Putting it together

With Excel 2002, you can engage students in active, problem-solving educational situations. For more information on how to use Excel in combination with other Office XP programs, please visit the Microsoft in Education Web site at http://www.microsoft.com/education/ 

Information in this document is subject to change without notice. Companies, names, and data used in examples herein are fictitious unless otherwise noted.
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What you will do:�


Gather real-world data from different sources including text files, databases, and the Web�


Use PivotTables and PivotCharts to explore questions using complex data�


Save your analysis as an interactive Web page�





Formula bar





Column heading





Name box





�





You can also select a different Office Assistant and set it to operate so that it fits your personality and the way you work. For example, if you prefer to use the keyboard, you can have the Office Assistant display tips on shortcut keys. Because all Office programs share the Office Assistant, any options you change will apply to the Office Assistant in your other Office programs as well. To customize or turn off the Office Assistant, click it and then click Options.








Active cell





Task Pane�





Row Headings�





Menu bar





Select all�





Status bar





Worksheet tab








Words to know:





Cell reference. Identifies a cell or a range of cells on a worksheet and tells Microsoft Excel where to look for the values or data you want to use in a formula.





Function. A predefined calculation that may be included in a cell and does a specific manipulation of data.�


Operator. A symbol or other character that specifies the type of calculation you want to perform on the elements of a formula.�


PivotTable. A special type of worksheet used to summarize and analyze data.





Query. To search a database for records that meet specific criteria.�


Range. Two or more cells on a sheet. The cells in a range can be adjacent or nonadjacent.





Result set. Data that is returned by a query, usually a subset of the original database.�


Source data. The data used to create a PivotTable, or the data imported into Excel through a database or Web query.





Value. Converts a text string that represents a number into a number.








�





Collecting real-world data is an important part of making learning relevant and engaging. To learn how students can collect their own data through Web surveys, see the Microsoft in Education tutorial Gathering Information Online. �





�





There are many sources of public domain data on the Web. Try the United States Census Bureau at � HYPERLINK "http://www.census.gov" ��http://www.census.gov�/ and the National Science Foundation at � HYPERLINK "http://www.nsf.gov" ��hppt://www.nsf.gov�/ �





�





You can also import text files as Fixed Width files, in which the text fields are aligned in columns with spaces between each field.�





�





When working with text files, use a non-proportional font such as Courier New so that your fields of text line up.








�





If the file you want to import contains tables, convert the tables to text before saving the file as a text file. 











�





Microsoft Query may need to be installed on your system. To do this you will need Microsoft Office XP software, or ask your network administrator.�





�





If you want more information about the Filter Data dialog box, click the help button in the lower left corner of the dialog box.�











You can also open any of the Chart Wizard dialog boxes from the shortcut menus when you right click the appropriate place on your PivotChart.�





�





When collecting information from a website that changes frequently, such as weather or stock market information, create a refreshable query so that the spreadsheet will always have the most recent data.
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